Criar modelos de certificado de CA do Windows
para CUCM
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Introduction

Este documento descreve um procedimento passo a passo para criar modelos de certificado em
Autoridades de Certificacdo (CA) baseadas em Windows Server, que sdo compativeis com os
requisitos de extensao X.509 para cada tipo de certificado do Cisco Unified Communications
Manager (CUCM).

Prerequisites

Requirements
A Cisco recomenda que vocé tenha conhecimento destes topicos:

- CUCM versao 11.5(1) ou posterior
- O conhecimento basico da administracao do Windows Server também é recomendado

Componentes Utilizados
As informacgdes neste documento sao baseadas nestas versdes de software e hardware:

- As informagdes neste documento sdo baseadas no CUCM versao 11.5(1) ou posterior.
- Microsoft Windows Server 2012 R2 com servicos de autoridade de certificacdo instalados.
The information in this document was created from the devices in a specific lab environment. All of

the devices used in this document started with a cleared (default) configuration. Se a rede estiver
ativa, certifique-se de que vocé entenda o impacto potencial de qualquer comando.



Informacgdes de Apoio

Ha cinco tipos de certificados que podem ser assinados por uma CA externa:

Certificado Uso
Apresentado no registro de
dispositivo seguro, pode assinar
arquivos CTL (Certificate Trust
List)/ITL (Internal Trust List),
usados para interagdes seguras
com outros servidores, como

CallManager

Servigos afetados

-Cisco Call Manager
-Cisco CTI Manager
-Cisco TFTP

troncos SIP (Session Initiation

Protocol) seguros.

tomeat protocolo HTTPS.

Apresentado para interagoes do

-Cisco Tomcat

-SSO (Single Sign-On, login
unico)

‘Mobilidade de ramal
-Corporate Directory

Usado para geragao de arquivos de

backup, bem como para interacao
de seguranca IP (IPsec) com

ipsec

-Cisco DRF Master
-Cisco DRF Local

gateways MGCP (Media Gateway
Control Protocol) ou H323.

Usado para gerar LSC (Locally
Significant Certificates) para

CAPF
telefones.

‘Funcgao de proxy da Cisco
Certificate Authority

Usado para criar uma conexao com

o TVS (Trust Verification Service),
quando os telefones ndo podem
autenticar um certificado

TVS

desconhecido.

-Servico de verificagao de
confianga da Cisco

Cada um desses certificados tem alguns requisitos de extensédo X.509 que precisam ser
definidos, caso contrario, vocé pode encontrar comportamentos incorretos em qualquer um dos

servicos mencionados acima:

Certificado

-Assinatura digital

-Codificacao de
CallManager chaves
-Codificacao de
dados
-Assinatura digital
-Codificacao de
chaves
-Codificacao de
dados
-Assinatura digital
-Codificacao de
chaves
-Codificacao de
dados

tomcat

ipsec

Uso de chave X.509 Uso Estendido de Chave X.509

-‘Autenticacao de servidor da
Web
-Autenticacao de cliente Web

-‘Autenticacao de servidor da
Web
-Autenticacao de cliente Web

-Autenticagéo de servidor da
Web

-Autenticagao de cliente Web
-Sistema final IPsec



-Assinatura digital

-Assinatura de -Autenticacao de servidor da
CAPF certificado Web

-Codificacao de -Autenticacao de cliente Web

chaves

-Assinatura digital

-Codificacao de -Autenticacao de servidor da
TVS chaves Web

-Codificacao de -Autenticacao de cliente Web

dados

Para obter mais informacdes, consulte o Guia de seguranca do Cisco Unified Communications
Manager

Configurar

Etapa 1. No Windows Server, navegue para Server Manager > Tools > Certification Authority,
conforme mostrado na imagem.
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Etapa 2. Selecione sua CA, navegue até Modelos de certificado, clique com o botao direito do
mouse na lista e selecione Gerenciar, como mostrado na imagem.
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Modelo do Callmanager / Tomcat/ TVS

As imagens a seguir exibem apenas a criagdo do modelo do CallManager; mas as mesmas
etapas podem ser seguidas para criar os modelos de certificado para os servigos Tomcat e TVS.
A unica diferenga é garantir que o nome do servigo respectivo seja usado para cada novo modelo
na etapa 2.

Etapa 1. Localize o modelo Servidor Web, clique nele com o botéo direito do mouse e selecione
Modelo Duplicado, como mostrado na imagem.
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Etapa 2. Em Geral, vocé pode alterar o nome, o nome de exibi¢ao, a validade, etc. do modelo de
certificado.



SubjectMame | Sever | lssusnce Requiemerts
Supersaced Templstes | Edensions | Sacuty
| Compatibity | General | Request Handing | Cryptography | Key Aestation

Template daplay nama:
(CalManagar CLCM |
Templals nama:
[CatManager CUCH |
Walkdty perod. Rearewal pancd:
L Sfirees  + L 6f[wesks |
[[] Publish cerificate in Active Drsctony
[ ] Do not automatically reenll if a duplcate certficate edists in Active
Derectony
| ok || Camcel || Mooy || Hep |

Etapa 3. Navegue até Extensions > Key Usage > Edit, conforme mostrado na imagem.



Compatibity | Genersl |mm1w1mm
Subgect Name | Server lssuance Racuments
Superseded Tempiates Ew-'u- Seasty |

Ta modify an exdension. sslect &. and then ook Edi

Extensions includad in this templats:
Apphcation Policies

Bamc Conslraints

Certficale Template infomation
lsusnce Polcies

Dmﬁmﬁﬂnrl.hm

‘mmmmmmm
Mﬂm

| Ok || Cancel || Mooy || Heb |

Etapa 4. Selecione essas opgoes e selecione OK, como mostrado na imagem.

- Assinatura digital
- Permitir troca de chaves somente com criptografia de chave (codificagdo de chave)
- Permitir criptografia de dados do usuario



Properties of New Template |2

Compatibity | Genersl | Request Handing | Crystography | Key Attestation
SubjectMame | Server | lssusnes Requiements

Speciy the mouinsd sigratuns and securty options for a key usage
ES A

Signature

[+ Digtal sgnature

[ Sigriature is proof of origin inonrepudiation)

|| Catificate signing
| CRL signing

Encnypiion

1) Alorw lomy mchange wihout ey snceryption fosy agresment)

(w1 Mow Rey exchangs anly wih key encryplion foy enciphesment]
[+ Alow sncryption of user data

R Y e

| OK || Cocedl || Mooy || Heb |

Etapa 5. Navegue para Extensdes > Politicas de aplicativo > Editar > Adicionar, como mostrado
na imagem.



mlwlmwlwlﬁwm
Subject Name |

Superseded Terplates | Secury
T modiy an edension. selact §. and then chick Edt,
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Application polices:
Server Authentication

| Make this extension critical

Etapa 6. Pesquise a autenticagao do cliente, selecione-a e selecione OK nesta janela e na
anterior, conforme mostrado na imagem.



[ ok || ot || Moty || e |

Passo 7. De volta ao modelo, selecione Aplicar e, em seguida, OK.



Compatibity | General | Request Handing | Crptography | Key Attestation
SubjectMame |  Sever | lssusnce Rlequiements
_ SuerededTemplstes | Bdensors | Secumy

To mody an extension, sebect i, and then chek B3R

Descrption of Appbcation Polcs:

Chent Authentication "
Server Authenbicabon

[T I T

Etapa 8. Feche a janela Console do modelo de certificado e, na primeira janela, navegue para
Novo > Modelo de certificado a ser emitido, como mostrado na imagem.



Fie Aoisgn  Wesw  Help
o 5 as B
o) Cortilication Aathomby [Local)
F F- Collals T8
Froodord Cortifizaton
e L LT

Piofaduiey Revpstild
Fasied Baquy

et ere Tarnplebe

Cinatwn & npws @om in ths containar.

Etapa 9. Selecione o novo modelo CallManager CUCM e selecione OK, como mostrado na

imagem.
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Etapa 10. Repita todas as etapas anteriores para criar modelos de certificado para os servigos
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Tomcat e TVS, conforme necessario.

Modelo de IPsec

Etapa 1. Localize o modelo Servidor Web, clique nele com o botéo direito do mouse e selecione

Certificate Hegquest Agert
Corifcate Requeat Agert

[ ox

Modelo Duplicado, como mostrado na imagem.
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Etapa 2. Em Geral, vocé pode alterar o nome, o nome de exibi¢ao, a validade, etc. do modelo de
certificado.

[IPSEC CUCM

Torrplabe fume
[IPSEC CLCM

Winbchty peawiiced: Fianevwal panod:

L 2lman v [ wosks

[ Publish cestficate in Active Directory

|| Do ot sutomaticaly reenrl f a duplcale cortficatle exisls in Active
Direciory

Etapa 3. Navegue até Extensions > Key Usage > Edit, conforme mostrado na imagem.



Compatibity | Genersl |mm1w1mm
Subgect Name | Server lssuance Racuments
Superseded Tempiates Ew-'u- Seasty |

Ta modify an exdension. sslect &. and then ook Edi

Extensions includad in this templats:
Apphcation Policies

Bamc Conslraints

Certficale Template infomation
lsusnce Polcies

Dmﬁmﬁﬂnrl.hm

‘mmmmmmm
Mﬂm

| Ok || Cancel || Mooy || Heb |

Etapa 4. Selecione essas opgoes e selecione OK, como mostrado na imagem.

- Assinatura digital
- Permitir troca de chaves somente com criptografia de chave (codificagdo de chave)
- Permitir criptografia de dados do usuario



Properties of New Template |2

Compatibity | Genersl | Request Handing | Crystography | Key Attestation
SubjectMame | Server | lssusnes Requiements

Speciy the mouinsd sigratuns and securty options for a key usage
ES A

Signature

[+ Digtal sgnature

[ Sigriature is proof of origin inonrepudiation)

|| Catificate signing
| CRL signing

Encnypiion

1) Alorw lomy mchange wihout ey snceryption fosy agresment)

(w1 Mow Rey exchangs anly wih key encryplion foy enciphesment]
[+ Alow sncryption of user data

R Y e

| OK || Cocedl || Mooy || Heb |

Etapa 5. Navegue para Extensdes > Politicas de aplicativo > Editar > Adicionar, como mostrado
na imagem.



Compatibity | General Hnumﬁlumulmm
Subject Name

Superseded Templates | Secusty

To modify an exdension, sslect i, and then chick Edit.
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Application polices:
Server Authentication

| Make this extension critical

Etapa 6. Procure a autenticagdo do cliente, selecione-a e, em seguida, OK, como mostrado na
imagem.



ok | Cmced || Mo [ Wb |

Passo 7. Selecione Add novamente, procure IP security end system, selecione-o e selecione OK
nesta e na janela anterior também.



#n applcation pokcy (caled enhanced ey usage in Windows 2000)
defines how a cetficate can be used. Sslect the apploation poboy requrd
For walbd sgnatures of cedificabes imsd by this bemplate.

| ok || Cocel || epy || Heb |

Etapa 8. De volta ao modelo, selecione Apply e, em seguida, OK, como mostrado na imagem.



mlwlmm.lwyw
Supeseded Tempistes | Edensons Secusty

T modly an edenson, sshect i, and then chek B

Bxtensons included in ths template:
Appleation Policies

[Basic Constrmnis

Cartficale Tamplsbe famation
lssunnca Pobces

Ky Lisage

Descrpbon of Applcation Polces:
Chert futhertication A

IP securty end system
Server Authenbcabon

[ ok || comca |[ mooy |[ ne |

Etapa 9. Feche a janela Console de modelos de certificado e, na primeira janela, navegue para
Novo > Modelo de certificado a ser emitido, como mostrado na imagem.
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Modelo CAPF

Etapa 1. Localize o modelo CA raiz e clique nele com o botao direito do mouse. Em seguida,

selecione Duplicar modelo, como mostrado na imagem.
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Etapa 2. Em Geral, vocé pode alterar o nome, o nome de exibi¢ao, a validade, etc. do modelo de
certificado.

Valdity peniod: Renewal penod:
| Slwean |__6||wesks |

] Publish camtfizals in Active Disctory

] Do not automatically resrrol i a duplicate cortficate exists in Active
Dt oy

Etapa 3. Navegue até Extensions > Key Usage > Edit, conforme mostrado na imagem.



Compatblty | Gened | lssuance Requimments
Superseded Tempistes | Edensons | Secusy

To modify an edension, sesct 1, and then dick EdE.

Extensions included in this template:
Apphcation Polcies

Bxsic Constrants

Certficate Templabe Information
suance Poboes

ok || Cwcel || Ao || Hb |

Etapa 4. Selecione essas opgdes e selecione OK, como mostrado na imagem.

- Assinatura digital
- Assinatura de certificado
. Assinatura de CRL



Properties of New Template |2

Compatibity | Genersl | Request Handing | Crystography | Key Attestation
SubjectMame | Server | lssusnes Requiements

Speciy the mouinsd sigratuns and securty options for a key usage
ES A

Signature

[+ Digtal sgnature

[ Sigriature is proof of origin inonrepudiation)

|| Catificate signing
| CRL signing

Encnypiion

1) Alorw lomy mchange wihout ey snceryption fosy agresment)

(w1 Mow Rey exchangs anly wih key encryplion foy enciphesment]
[+ Alow sncryption of user data

R Y e

| OK || Cocedl || Mooy || Heb |

Etapa 5. Navegue para Extensdes > Politicas de aplicativo > Editar > Adicionar, como mostrado
na imagem.
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Application polices:
Server Authentication

| Make this extension critical

Etapa 6. Procure a autenticagdo do cliente, selecione-a e, em seguida, OK, como mostrado na
imagem.



ok | Cmced || Mo [ Wb |

Passo 7. Selecione Add novamente, procure IP security end system, selecione-o e depois
selecione OK nesta e na janela anterior também, como mostrado na imagem.



#n applcation pokcy (caled enhanced ey usage in Windows 2000)
defines how a cetficate can be used. Sslect the apploation poboy requrd
For walbd sgnatures of cedificabes imsd by this bemplate.

| ok || Cocel || epy || Heb |

Etapa 8. De volta ao modelo, selecione Apply e, em seguida, OK, como mostrado na imagem.
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T modly an edenson, sshect i, and then chek B

Bxtensons included in ths template:
Appleation Policies

[Basic Constrmnis

Cartficale Tamplsbe famation
lssunnca Pobces

Ky Lisage

Descrpbon of Applcation Polces:
Chert futhertication A

IP securty end system
Server Authenbcabon

[ ok || comca |[ mooy |[ ne |

Etapa 9. Feche a janela Console de modelos de certificado e, na primeira janela, navegue para
Novo > Modelo de certificado a ser emitido, como mostrado na imagem.
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Etapa 10. Selecione o novo modelo CAPF CUCM e selecione OK, como mostrado na imagem.
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Gerar uma Solicitagdo de Assinatura de Certificado

Use este exemplo para gerar um certificado do CallManager com o uso dos modelos recém-
criados. O mesmo procedimento pode ser usado para qualquer tipo de certificado. Vocé s6
precisa selecionar o certificado e os tipos de modelo de acordo:

Etapa 1. No CUCM, navegue para OS Administration > Security > Certificate Management >
Generate CSR.



Etapa 2. Selecione essas opgoes e selecione Gerar, como mostrado na imagem.

- Finalidade do certificado: CallManager

. Distribuiééo: <Pode ser aienas iara um servidor ou iara varias SANs>
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Etapa 3. Uma mensagem de confirmacgao é gerada, como mostrado na imagem.
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Etapa 4. Na lista de certificados, procure a entrada com o tipo CSR Only e selecione-a, como
mostrado na imagem.
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Etapa 5. Na janela pop-up, selecione Download CSR e salve o arquivo no computador.
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Etapa 6. No navegador, navegue até este URL e insira as credenciais de administrador do
controlador de dominio: https://<yourWindowsServerlP>/certsrv/.

Passo 7. Navegue para Solicitar um certificado > solicitagdo de certificado avangado, como
mostrado na imagem.
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Etapa 8. Abra o arquivo CSR e copie todo o seu conteudo:
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Etapa 9. Cole o CSR no campo de solicitagao de certificado codificado na Base 64. Em Modelo
de certificado, selecione o modelo correto e selecione Enviar, como mostrado na imagem.
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Etapa 10. Por fim, selecione Base 64 encoded e Download certificate chain, o arquivo gerado
agora pode ser carregado no CUCM.
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Verificar

O procedimento de verificagado €, na verdade, parte do processo de configuragao.

Troubleshoot

No momento, ndo ha informacdes especificas de solugao de problemas disponiveis para essa
configuracao.



Sobre esta tradugao

A Cisco traduziu este documento com a ajuda de tecnologias de tradugéo automatica e
humana para oferecer conteudo de suporte aos seus usuarios no seu proprio idioma,
independentemente da localizagao.

Observe que mesmo a melhor tradugao automatica nao sera tao precisa quanto as realizadas
por um tradutor profissional.

A Cisco Systems, Inc. ndo se responsabiliza pela precisdo destas tradugdes e recomenda
que o documento original em inglés (link fornecido) seja sempre consultado.



